
Here at SumProduct we audit many models.  With one of the most 
experienced teams of model auditors around, you start to recognise and 
look out for common errors in financial spreadsheets.  One common 
are of malignant modelling is the inability of many analysts to convert 
an annual interest rate into a monthly or quarterly rate correctly.  
Sometimes the error is immaterial; other times, it can cause major 
issues (e.g. for bank forecasts).  This isn’t so much an Excel issue as a 
mathematical problem, but it is still relevant to financial modellers and 
more often than not, it’s calculated incorrectly.

The key thing any modeller charged with this exercise must do is read the 
debt term sheet or deposit account prospectus to see what the effective 
annual rate is.  Accountants talk about nominal interest rates and such 
like, but the effective annual rate is the amount of interest expressed as 

a percentage of the opening debt or cash balance if interest were to be 
paid and calculated as per the terms of the underlying document.

It’s easier said than done.

Consider this example: consider a loan of $100 where interest is 
calculated in arrears on a monthly compounding basis paid quarterly at 
the end of each quarter.  The effective rate is determined to be 12%.  
The question is, what is the appropriate monthly rate be for cashflow 
calculations?

Who said 1%?  That’s a common answer, derived as 12% divided by the 
number of months in a year (12).  It sounds good, but if we crunch the 
numbers we will get the following result:

On a $100 balance with interest of 1% monthly paid quarterly, the total interest for the year will be $12.12 – that’s an effective annual rate of 12.12% 
rather than 12% (12.00%).  This is not correct, as interest is being rolled up at the end of each of the first two months in the quarter and is attracting 
further interest, i.e. interest is compounding and has not been taken into account by simply dividing the annual rate by the number of months in a year.

So, what about using the compounding formula instead?  Interest can then be calculated as

=(1+12%)1/12 - 1
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Celebrations are like buses… You don’t see one for ages and then two come along 
in quick succession.  Last month saw us celebrate our fourth birthday (yup, we’ve gone fourth and multiplied!) and this month sees us 
raise our bat to complete an unbeaten half century – 50 not out!

Yet again, there’s plenty of updates in this issue – this time for both Power BI and Power Query – with the latter now getting its own 
regular article in this newsletter too (and about time too, I hear you say) as well as both forming part of our new flagship training course.

With the usual A to Z of Excel Functions, a Keyboard Shortcuts “refresher”, training updates et al, the newsletter that 
continues to grow, er, continues to grow.  You know, I really should get this edited professionally (hey! – Ed.)

And before I forget – talking of celebrations – HAPPY NEW YEAR!!  Wishing you all a prosperous 2017 as we hope to see 
some of you this year at our Excel Unlocked summits, our training courses or as returning or new clients.  All the best!

That’s it until next year.  Seasons greetings to you all. Liam Bastick, Managing Director, SumProduct
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This equates to 0.9489% per month.  This will take into account compounding – well, sort of:

This hasn’t worked either: interest has been under-accrued (that’s a good word I’ve just made up) as only $11.49 has been computed for the year – 
an effective rate of 11.49%.

Here, the calculation is again too simplistic as it does not take into account that the interest is paid quarterly.  This means that compounding 
throughout the year does not occur, hence the shortfall of 0.51%.

The correct formula is in fact:

=(1+(Effective Annual Interest Rate x Payment Frequency / Months in Year))1/Payment Frequency - 1

If payments are made once every three months then there are four payments (equal to Months in Year / Payment Frequency or 12 / 3) each year.   
At these points, compounding stops.  Therefore, the interest rate of 12% per annum is effectively 3% per quarter.  The compounding formula can 
then be applied to the quarterly rate to get the monthly rate accordingly:

=(1+3%)1/3 - 1

This equates to 0.9902%.  This is correct, viz.

Success!

This is the formula that should be applied to calculate the appropriate monthly interest rate from a quoted effective annual one.  It might not surprise 
you to learn we have developed a simple Excel file that provides examples and a template that may be used to convert annual interest rates to the 
correct monthly ones.

You can check out other useful ideas at www.sumproduct.com/thought.

As usual, it was too late for our last newsletter, but late November saw Microsoft release its latest Power BI Desktop update, which contained some 
of the most eagerly awaited feature updates and improvements yet, if Uservoice is to be believed.  

By area, the list of updates by category includes:

	 •	 Report View

		  o	Dropdown slicer
		  o	Hierarchical axis
		  o	Matrix conditional formatting
		  o	 Table and matrix column formatting
		  o	 Axis label and title colour control
		  o	 Phone reports scrolling

Power BI Desktop Latest Update
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	 •	Analytic

	 	 o	 Clustering (as a preview)
	 	 o	 Forecasting: now available on Power BI on the web
	 	 o	Groups: Ribbon entry point

	 •	Data Connectors

	 	 o	 Spark DirectQuery
	 	 o	OData connector: folding of expand record operations
	 	 o	 Enhanced “combine binaries” experience
	 	 o	 Azure Analysis Services
	 	 o	Web connector updates

	 •	Query Editing Improvements

	 	 o	 Improved “function authoring” experience
	 	 o	 Support for percentage data type
	 	 o	Maximize / Restore buttons in the Navigator and Query Dependencies dialogs

A summary of the major updates, can be found in Microsoft’s video here.

Let’s take a look at each in more detail.

Like trips to the butchers, users cannot seem to get enough of slicers.  Last month saw the release of the date slicer, and in quick succession, it has 
now been befriended by the dropdown slicer.  This slicer is particularly useful if you are tight on space in your report canvas or if you have a lot of 
category items in your slicer which you do not want to take up valuable real estate.

When you create a normal list slicer, you can turn it into a drop down by using the dropdown option next to the ‘Clear’ button.

With this latest release, Microsoft has improved how visuals may be viewed which contain a hierarchy through a new hierarchical axis.  This allows 
you to clearly see the hierarchy within the visual.  As you drill, you’ll be able to better understand where you are in the hierarchy. (Is this the new 
world record for the number of hierarchies in one paragraph? – Ed.)

You can now use this dropdown slicer the same way as the list slicer.

Dropdown slicer

Hierarchical axis
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You can use hierarchical labels by turning off the label concatenation experience in the formatting pane:

Back in May, Power BI added the feature that allowed you to conditionally format measures in tables.  Now, this has been extended to work for 
measures in matrices as well.

You can turn on conditional formatting by opening the field well menu for the measure and selecting ‘Conditional formatting:

Matrix conditional formatting
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In the dialog, you can change various settings, including picking out which colours you wish to use:

Once you hit okay, you’ll see the formatting applied:

It’s not just conditional formatting that’s available for matrices: the November update has also added the ability to format columns in tables and 
matrices too.  This lets you set the font and background colour for any column.

Table and matrix column formatting
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In the formatting pane, you can now see the ‘Column formatting’ card.  When you expand it, you will be able to select a column in the dropdown list 
and pick the font and background colours.  You can also choose whether these settings should apply to headers and totals or only the values:

Just as in Excel, for most charts you can change the colours of your axis labels.  This support has been expanded to all charts now.  Additionally, you 
can now format your axis title colour separately from the axis labels.

Axis label and title colour control
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Require your Business Intelligence on the go?  Back in September, Microsoft released a preview of phone report layouts, which allowed you to create 
custom layouts of your report for users to view when they are on their phones (presumably while they are driving…).  This release makes an update 
to that preview: now, you can extend the length of your phone report and allow users to scroll to see the additional content.

One long-awaited analytical feature added to Power BI this update is clustering.  Clustering lets you quickly find groups of similar data points in a 
subset of your data.  You can use clustering on your scatter chart by clicking the “...” and then by selecting ‘Automatically find clusters’.

When you select this, a dialog opens where you can decide how many clusters you want to find.  If you leave it blank, Power BI will automatically find 
the number of clusters it thinks makes the most sense concerning your data.

After the clustering algorithm runs, it will create a new categorical field with the different cluster groups in it.  This new field will be adding to your 
scatter chart’s legend field well bucket, which you can now use as a source of cross highlighting, just like any other legend field.  You can also find it 
in your field list and use it in new visuals – again, just like any other field.

Phone reports scrolling

Clustering (preview)
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You can select ‘Edit clusters’ in the field list menu to configure it further, viz.

In this dialog, you can rename the field, name each of the clusters, or adjust the number of clusters you want to find.

If you want to find clusters using more than two measures, you can use a Table to add all the fields you want to use and run the clustering algorithm 
using the same process.
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We will add the new field to the Table and the field list for you to use in your other charts.

One way for you to use your newly-created cluster field, for example, 
would be to use custom visuals to do further analysis and evaluate the 
clusters.  You might use the cluster column and each of the associated 
measures in a radar chart to see the aggregate of each measure for each 

cluster.  You might use the cluster column and one of the measures in a 
box and whiskers plot to see the distribution of values for that measure 
in each cluster.  This can help you determine the minimum, maximum 
and median values for that measure within each cluster very easily.

Clusters are not re-evaluated on Refresh, which may or may not be a blessing.  Microsoft argues that this is intentional so that you may easily save 
your clusters and re-evaluate when needed.  New points will therefore be assigned to a (blank) cluster.

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Do note that since this is a preview feature, you will need to enable it in the ‘Preview Features’ tab in the ‘Options’ dialog.

Forecasting was previewed back in September.  With this release, the feature is generally available to everyone, so you no longer need to enable it 
through the Options dialog.  Additionally, you can now see your forecasting in reports on the web and pinned tiles.  You can also create new forecasts 
in the web report editing experience.

Microsoft has added two new ways to create groups to make it even quicker and easier to use.  You can create and edit groups from the ‘Modeling’ tab.

Forecasting – now available in the Power BI on the web

Groups: Ribbon entry points
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You can also create a new group from the ‘Data / Drill tab’ when you are on a chart:

Microsoft has now added DirectQuery support when connecting to Spark.  This includes the HDInsight Spark connector (under Get Data -> Azure) as 
well as the Spark connector for other Spark distributions (under Get Data -> Other).  It should be noted that this new DirectQuery mode is currently 
in Preview and not yet supported for Power BI web report consumption.

When using one of the Spark connectors, you are now able to pick which Connectivity Mode to use, either Import or DirectQuery. 

This latest update also provides a new feature to help improve the performance of complicated data models you are accessing through an OData 
feed.  Microsoft has added support for the underlying OData Service which will perform the expand record operation rather than have this operation 
undertaken in Power BI.  By having the underlying OData service handle this operation, the transaction is more efficient since less data is passed to 
Power BI.  That makes sense to us.

One common scenario in Power BI consists of leveraging one of the folder-like connectors (such as Folder, SharePoint folder, HDFS, etc.) to combine 
multiple files with the same schema into a single logical table.

If you have no idea what DirectQuery is and wish to find out more, check out Microsoft’s documentation on the subject here.

Spark DirectQuery

OData Connector – folding of expand record operations

Enhanced “combine binaries” experience
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Before this latest release, users could combine Text or CSV files by using the “combine binaries” transform. However, this transformation had a few gaps:

	 •	 It wouldn’t account for transformations required on each file before combining them into a single table.  A typical example of this is Text / CSV 
		  files with column headers.  You instead had to combine files into a single table first, then filter out the “header values” as a filter rows operation

	 •	 This “combine binaries” transform only worked (with above limitations) for Text or CSV files, but not for any of the other supported file formats  
		  (such as Excel Workbooks, JSON files, etc.).

With this release, the “combine binaries” transform has been improved so that:

	 •	 It analyses the input files and detects the right file format to use (e.g. Text vs. Excel Workbook)
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	 •	 It provides you with the chance to select a specific object from the first file (for example, a spreadsheet to use)

	 •	 It automatically creates a few different artefacts: 

	 	 o	 An example query that performs all required “extraction” steps in a single file

	 	 o	 A function query that parameterises the file / binary input to the exemplar query.  Both the exemplar query and the function query are linked, 	
	 	 	 so that changes to the exemplar query are reflected in the function query

	 	 o	 It applies the function query to the original query with input binaries (i.e. the Folder query), so that it applies the function query for binary inputs 	
	 	 	 on each row, then expands the resulting data extraction as top-level columns.

With this new approach, 
you can easily combine 
all binaries within a folder 
as long as they have a 
homogeneous file type and 
structure (i.e. columns).  
You can also easily apply 
additional transformation 
/ extraction steps by 
modifying the exemplar 
query without having to 
worry about any additional 
function invocation steps, 
since they are automatically 
generated.

In the October update, the public preview of Microsoft 
Azure Analysis Services was announced.  You can now 
connect to Azure Analysis Services in the Power BI 
Desktop.  To connect, select ‘Analysis Services’ in the 
‘Get Data’ menu:

Azure Analysis Services
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In the dialog, enter the server name, which you can find in the Azure portal.  You will need to use the entire server name including the asazure:// prefix.  
You can also include the name of the tabular model database or perspective you want to connect to.  If you do not include this, you can select the 
database or perspective on the Navigator dialog that follows.  Also, be sure to leave the ‘Connect live’ option selected:

Microsoft states that they are currently working on improvements 
to the refresh of cloud based data sources.  As part of this, one of the 
changes made recently is that new datasets that leverage import from 
Web pages will not be automatically configured for refresh in Power BI 
on the web and will require the use of a gateway.  If you would like to 

use this capability, please consider using the Personal Gateway or On-
Premises data gateway.  Microsoft has emphasised that the software 
giant is working on removing this restriction in the near future.  Watch 
this space.

As a general case for one of the capabilities described in the “combine 
binaries” scenario, the latest release has made it easier to update 
function definitions without the need to maintain the underlying M code. 

When a function definition has been created based on another query (e.g. 
using the “Convert to Function” option on the Queries context menu), a 
link will be created between the original / exemplar query and the newly 

generated function, so that you can simply modify the exemplar query 
steps and the linked function will be automatically updated for them.  
When using query parameters, creating a function out of a query will 
allow you to use function inputs to replace parameter values in the 
generalized function query.

This latest release adds support for Percentage data types so they can 
easily be used in arithmetical operations.  An input value such as “5%” 
will be automatically recognized as a Percentage value and converted to 
a 2-digit precision decimal number (e.g. 0.05), which can then be used 
in arithmetical operations within the Query Editor or the Data Model.

Besides automatic type recognition from schemaless sources (such as 
Text, CSV or HTML), users can also convert any value to Percentage by 
using the Change Type options in the Query Editor: column header type 
indicators, ‘Change Type’ menu under the Home or Transform column 
tabs, ‘Change Type Using Locale’ transform via context menu, etc.

Web connector updates

Improved “function authoring” experience

Support for Percentage Data Type
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The Navigator and Query Dependencies dialogs support window resizing by dragging the bottom / right edges of the dialog.  In this release, it  also 
makes it possible to maximise / restore these dialogs by exposing ‘Maximize’ and ‘Restore’ icons in the top-right corner of the dialogs so that they 
behave like standard Windows dialogs.

With this update, Microsoft has added support for specifying ‘HTTP Request Headers (Parameters)’ within the ‘Web connector’ dialog.  Users can 
specify header name / value pairs from the ‘Advanced’ mode in this dialog:

For the second month running, you will probably agree Microsoft has gone to town adding updates to this free and versatile software.  If you are 
a regular user of Power BI, do remember that you can all still vote for other features that you would like to see in the Power BI Desktop by visiting 
www.powerbi.com.  And if you are not an experienced user but would like to find out more (including venturing on a training course) feel free to 
drop us a line at contact@sumproduct.com.

Maximize / Restore buttons in the Navigator and Query Dependencies dialogs

Web Connector: UX support for specifying HTTP Request Headers

Microsoft recently announced 10 new data transformation and connectivity features that have been requested by customers.  These updates 
include the following new or improved data connectivity and transformation features:

	 •	Web Connector: UX support for specifying HTTP Request Headers
	 •	OData Connector: support for ‘Select Related Tables’ option
	 •	Oracle Connector: improved Navigator preview performance
	 •	 SAP HANA Connector: enhancements to parameter input UX
	 •	Query Dependencies view from Query Editor

November 2016 updates for Get & Transform in Excel 2016 / Power Query add-in 
(Excel 2010 and 2013)

	 •	Query Editor Ribbon support for scalar values
	 •	Add custom column based on function invocation
	 •	 Expand & Aggregate columns provide support for ‘Load More’ values
	 •	Convert table column to a list: new transformation
	 •	 Select as you type in drop-down menus.
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In this update, Microsoft has also added relationship detection support for OData V4 feeds.  When connecting to OData V4 feeds, users will be able 
to use the ‘Select Related Tables’ button in the ‘Navigator’ dialog to help you easily select all the tables needed for your reports:

The performance for previewing tables in the ‘Navigator’ dialog when connecting to Oracle databases has been improved.  In most cases, previews 
should take up to 30% less time to display than before.

Enhancements have been made to the parameter input controls within the ‘Navigator’ dialog when connecting to SAP HANA.  These enhancements 
include:

	 •	 For single-selection parameters:
		  o	 Support for typing values, in addition to selecting values from the drop-down list
		  o	 ‘Member ID’ and ‘Member Caption’ are now exposed within the drop-down list

	 •	 For multi-selection parameters:
		  o	 ‘Member ID’ and ‘Member Caption’ are now exposed within the drop-down list
		  o	Users can leverage the ‘Search’ box to search across both ‘Member ID’ and ‘Member Caption’ fields.

One of the most popular requests in the Data preparation area for the 
past several months has been having the ability to easily understand 
dependencies across all queries in a given workbook.  In this release, a 
‘Query Dependencies’ view in the ‘Query Editor’ (under the ‘View’ tab 

on the Ribbon) has been added that allows users to see all queries and 
dependencies on other queries or data sources at a glance, as well as an 
indicator of their ‘Load’ status.

OData Connector: support for ‘Select Related Tables’ option

Oracle Connector: improved Navigator preview performance

SAP HANA Connector: enhancements to parameter input UX

Query Dependencies view from Query Editor

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

‘Query Editor’ Ribbon support for common operations has now also been included when dealing with scalar-type queries.  This includes new 
‘Contextual Ribbon’ tabs that expose common transformations for Text, Date / Time and Number values.

A common scenario when working with custom functions is invoking such functions over each row in a table.  Before this update, users had to create 
custom columns and manually type an M expression to invoke a custom function with the right set of arguments.  However, with this update, users 
may now invoke a custom function over a table.  Users can now simply leverage the new ‘Invoke Custom Function’ operation from the ‘Add Column’ 
tab on the Ribbon.

This dialog gives you the option to pick one of the custom functions defined in the current workbook and specify input arguments, which may include 
static values or references to other columns in the current table query.

Query Editor Ribbon support for scalar values

Add custom column based on function invocation
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When dealing with columns with nested data structures, such as Records 
or Tables, it is a common requirement that not all nested structures 
have the same schema.  Excel leverages schema detection to provide 
information such as the list of nested columns in the ‘Expand & Aggregate 
column’ experiences.  Before this update, Excel would only look at the 
top few rows of nested data to construct the list of columns to display.

With this update, the ‘Load More’ option has been added to the existing 
features to the ‘Expand & Aggregate columns’ list in ‘Query Editor’ so 
that users can tell Excel to look at more rows to detect additional nested 
fields / columns.  When using the ‘Load More’ option, Excel scans up 
to the top 1,000 rows of nested data to calculate the list of columns to 
display in the ‘Expand & Aggregate columns’ list.

With this update, users may readily turn a given column within a table into a list.  All you have to do is select the column in the ‘Query Editor Preview’ 
and use the newly added ‘Convert to List’ button in the ‘Transform’ tab on the Ribbon.

The output lists can be further transformed by using the contextual ‘Lists Tools’ Ribbon tab to perform common operations (such as ‘Remove Duplicates’, 
‘Sort’, ‘Perform Statistic Calculations’, etc.).  ‘List Queries’ may also be used as input for the ‘Accepted Values’ property in ‘Query Parameters’.

Expand & Aggregate columns provide support for “Load More” values

Convert table column to a list: new transformation

With this update, the navigation and selection interactions within drop-
down menus have been improved with the addition of select-as-you-
type capabilities.  This allows users to type one or more characters and 
these will get matched with the prefix of drop-down menu items.  This 

is something users have been wanting for years.  This behaviour is now 
available in all ‘Get & Transform’ drop-down menus, but it is particularly 
useful for menus with many list items (such as the ‘Change Type with 
Locale’ dialog or the single-value parameter lists for SAP HANA, etc.).

Select as you type in drop-down menus
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If you haven’t started playing with Power Query / Get & Transform, 
perhaps now is a good time to get acquainted.  Microsoft has been going 
gangbusters on several fronts recently – and it’s all free.  Power Query 
is essential for turning data lying around into information with Power 
BI then on hand to assist providing those much sought after analytical 

insights.  We have courses that explain the rudiments of both of these 
plus how Power Pivot fits in too.  For more details on course outline, 
pricing and next available sessions, check out the website or drop us a 
line at training@sumproducct.com.

Having extracted the data from the appropriate source (more on the details of this process in later blogs), the transformation can take place – 
cleaning away any unrequired detail, merging where appropriate (all without the erstwhile VLOOKUP), and enhancing by calculating and adding new 
columns. There is even a button to unpivot data!

Talking of Power Query / Get & Transform, December saw the start of 
our latest blog series, with a weekly post on this very subject.  For those 
looking to seek out the power of Power Query, you might wish to take a 
gander.  We’ll be reproducing some of these articles each month in these 
newsletters (we start with the first one below).  You can stay up to date 
though by checking them out at source at www.sumproduct.com/blog.

Regular users of Excel are well aware of the possibilities to manipulate 
and present data that has come from a variety of sources.  Getting that 
data ready for each solution can be time consuming – complex solutions 
can require VBA or SQL expertise, and simple solutions often involve 
repetitive tasks before the data is ready to be uploaded to PivotTables. 

Enter Power Query, which has been designed for Excel users to enable 
the rapid uploading and cleaning of data without needing to turn (in)to 
VBA and SQL experts. 

Power Query is a free add-in ETL (extract, transform and load) tool for 
users of Excel 2010 (Professional Plus with Software Assurance version 
only) and 2013, where it has its own tab on the Ribbon, and is now fully 
integrated into Excel 2016, where it can be found on the data tab under 
‘Get & Transform’.

As shown below in Excel 2013, Power Query is able to upload from many 
sources:

Power Query Pointers
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Whilst the majority of transformations can be done with no formulas or coding, each step is stored in M, the language behind Power Query. For the 
more ambitious user, M can be used to refine and build on what Power Query creates automatically.

The final step for the ETL tool is to load - to excel tables, Power Pivot, Power BI, or just store a query for use by other queries; a building block that 
can be re-used.

Since everything is recorded in M, then to reload to the same destination – simply refresh. 

More next month…

December was a busy month!  The end of 2016 also saw the successful completion of the first running of our new three-day training course, the 
catchily-titled “Power Pivot, Power Query and Power BI”.  Yes, maybe we need to change the name.  We’ll get back to you on that one.

As the Pet Shop Boys announced, “It’s ASIN”.  Yes, for the religious amongst you, we have finally committed ASIN.  It’s no use; the further we delve 
into this ad hoc series, the more bored we get and the worse the puns become.  

Assuming you know how to switch on a computer and have access to Excel 2010 or better (with one or two caveats), this course covers all you need 
to know to hit the ground running with Microsoft’s powerful suite of data analysis and business intelligence tools.

This course covers:

	 •	 the basics:  how to manipulate PivotTables and create Tables in Excel
	 •	 the power of Power Pivot: how to bring in data, why you should bring it in that way, how to link data from different sources and create 	
		  calculated fields and measures using Data Analysis eXpressions (DAX)
	 •	 the essentials of Power Query: how to automate tidying up data, manipulate it, and create directories to drop in source data
	 •	 the analysis of Power BI: using both the Desktop version an its online counterpart, learn how to create amazing interactive dashboards quickly.   
		  Access hidden insights within minutes and create an interface where end users can answer their own questions
	 •	when to use what where and why: it’s daunting realising all the power at your fingertips.  We help you identify the order to use these tools in  
		  to get the most out of your data.

Remember, from data you can get information.  Information leads to knowledge and ultimately wisdom.  Isn’t it time you wised up?

You can find out more in the Courses section of our website.  For further information, drop us a line at training@sumproduct.com.

A New Course, Of Course

The A to Z of Excel Functions: ASIN
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On a more serious note, this function returns the arcsine, or inverse sine, of a number.  Yes, we are deep in trigonometric functions this month.  The 
arcsine is the angle whose sine is number.  The returned angle is given in radians in the range - π/2 to π/2.

The ASIN function employs the following syntax to operate:

ASIN(number)

The ASIN function syntax has the following arguments:

	 •	number: this is required.  The sine of the angle required: this must be in the range from -1 to 1.

To express the arcsine in degrees, multiply the result by 180/PI( ) or use the DEGREES function.

Check out our example below:

The ASINH function returns the inverse hyperbolic sine of a number.  The inverse hyperbolic sine is the value whose hyperbolic sine is number, so 
ASINH(SINH(number)) equals number.

The ASINH function employs the following syntax to operate:

ASINH(number)

The ASINH function has only one argument:

	 •	 number: this is required and may be any real number.

Please see the example below:

Lazing at the beach and think you should get ATAN?  The ATAN function returns the arctangent, or inverse tangent, of a number.  The arctangent is 
the angle whose tangent is number.  The returned angle is given in radians in the range -π/2 to π/2.

The ATAN function employs the following syntax to operate: 

ATAN(number)

The ATAN function has only one argument:

	 •	number: this is required and should be the tangent of the angle you require.

To express the arctangent in degrees, multiply the result by 180/PI( ) or use the DEGREES function.

An example:

After ATAN, you might see that bronzed figure on the beach and you think, maybe I should get ATAN2.  Yes, this function returns the arctangent, or 
inverse tangent, of the specified x- and y-coordinates.  The arctangent is the angle from the x-axis to a line containing the origin (0, 0) and a point 
with coordinates (x_num, y_num).  The angle is given in radians between - π and π, excluding - π.

The ATAN2 function employs the following syntax to operate:

ATAN2(x_num, y_num)

The A to Z of Excel Functions: ASINH
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The ATAN2 has the following arguments:

	 •	x_num: this is required and represents the x-coordinate of the point
	 •	y_num: this is also required and represents the y-coordinate of the point.

It should be further noted that:

	 •	A positive result represents an anti-clockwise angle from the x-axis; a negative result represents a clockwise angle
	 •	ATAN2(a,b) equals ATAN(b/a), except that a can equal 0 in ATAN2
	 •	 If both x_num and y_num are 0, ATAN2 returns the #DIV/0! error value
	 •	 To express the arctangent in degrees, multiply the result by 180/PI( ) or use the DEGREES function.

Time for another example:

Now it’s time to talk a complete load of hyperbolics.  The ATANH function returns the inverse hyperbolic tangent of a number (“number”).  This 
number must be between -1 and 1 (excluding -1 and 1).  The inverse hyperbolic tangent is the value whose hyperbolic tangent is number, so 
ATANH(TANH(number)) must equal number.

The ATANH function employs the following syntax to operate:

ATANH(number)

The ATANH function contains only one argument:

	 •	number: this is required and should be any real number between 1 and -1, not including the two extremities.

Please see our final example for this newsletter:

December saw us in London and we were privileged enough to attend where we saw Australia’s own Joseph Lau retain his title as 
World Heavyweight Champion – no, that’s not it! – ModelOff’s world financial modelling champion as he managed to develop INDEX 
MATCH formulae in the time it takes us to type “December saw us in London”!  Congratulations Joseph.

We were on hand to extol to delegates the virtues of Power BI and to enjoy a free-flowing Excel Tips and Tricks session, which revolved 
heavily around the different types of drop down boxes, Data Tables and scaring the living daylights out of work colleagues. 

London also saw us hold discussions with several third-party training organisers and prospective clients.  You’ll find 2017 is going to 
see us with more of an active role in Brexit Land after the opening of our office there a few months ago.  Watch this space – or drop us 
a line at contact@sumproduct.com if you can’t wait!

The A to Z of Excel Functions: ATANH

ModelOff Finals
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 		
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Location Course Date Duration

Melbourne Financial Modelling for Mergers and 
Acquisitions 6th - 9th Feb 2017 4 days

Sydney Excel Tips and Tricks 6th Feb 2017 1 day

Sydney Financial Modelling 7th - 8th Feb 2017 2 days

Melbourne Power Pivot, Power Query and Power BI 20th - 22nd Feb 2017 3 days

Toronto Financial Modelling 6th - 7th Mar 2017 2 days

Toronto Power Pivot, Power Query and Power BI 8th - 10th Mar 2017 3 days

New York Financial Modelling 13th - 14th Mar 2017 2 days

New York Power Pivot, Power Query and Power BI 15th - 17th Mar 2017 3 days

Melbourne Financial Modelling 22nd - 23rd Mar 2017 2 days

Sydney Power Pivot, Power Query and Power BI 24th - 26th Mar 2017 3 days

Upcoming SumProduct Training Courses

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month we decided we’d continue 
going through the function keys – this time, with the F5 function key:

There are over 540 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file a
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Keystroke What it does

F5 Go To / Refresh File List

ALT + F5 Refresh

CTRL + F5 Restore window

SHIFT + F5 Find dialog box

CTRL + ALT + F5 Refresh all

Have you heard about the SumProduct 
Referral programme? If you successfully 
introduce us to a client we will pay you 10% 
of the net profits of the engagement won 
upon receipt of client payment. Sounds like 
a pretty good deal to us!

Terms and conditions apply.  Referrer must 
be over 18 years of age, able to issue an 
invoice and not be an employee, director, 
agent or other related party of the client 
engaged.  For further information, drop us a 
line at  contact@sumproduct.com.  We hope 
to hear from you!

Referral Programme
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